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1 Index

Estierra is a program for modeling the terrain of the earth. It reads standard USGS Digital Elevation
Model files (DEM’s) and converts them into three-dimensional models of the earth’s surface. These
models can be colored, shaded, highlighted and overlaid with topographic maps or aerial
photographs. This creates extremely realistic 3D images of the terrain. In addition, Estierra uses
OpenGL technology that gives it the ability to do high-speed animations of the terrains. This means
the terrains can be zoomed, panned and rotated in real-time. You can even fly over and through the
terrain using a mouse.

Basics
Building Terrains
DEM Reader Page
Topo Editor Page
3D Editor Page
Overlay Editor Page

DEM Files
DEM File Errors
Terrain Special Effects
3D Options
Saving/Loading Data
Printing, Copying and Saving
Environmental Options
Geographic Coordinate Systems

1.1 Basics

Here is basic information about Estierra and an overview of how it works:

Requirements
Uses For Estierra
System Requirements
Hardware Requirements
Terminology and Conventions

Getting Started
Overview
Getting Started
Startup Problems
Test Objects

1.1.1 Uses For ExTierra

Estierra can be used in a variety of ways.

Better than Google Earth. While Google Earth can display terrain models overlaid with aerial
photographs, the Google Earth Images are have relatively low resolutions which can miss subtle
terrain features and details. Estierra allows you to control the terrain resolution and choosing high
resolution aerial photographs allow you to see much more detail than Google Earth provides.

Recreation. Outdoor enthusiast such as hikers, mountain climbers, cave explorers, horse back
riders, skiers and mountain bike riders can use Estierra to plan routes and to familiarize themselves
with the terrain.

Earth Science. Geologist, hydrologists, and other earth scientist can use Estierra to analyze the
origin and formation of various surface features. For example, Estierra’s ability to view the terrain
from any angle and create sun-shadows from any direction allows you see very subtle variations in
the terrain. This makes it easy to see glacial remnants, river terraces, fault scarps, lava flows and
other features that are virtually invisible on topographic maps and aerial photos.
You can also create 3D geological maps that give a clear picture of how rock formations relate terrain
features.

Engineering. Estierra can be used by civil engineers for planning roads, bridges, parks and
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buildings. The ability to overlay various kinds of maps on the terrain allows you to take into
consideration the locations of existing improvements and how they relate to hills, streams and other
surface features.

Land Management. Estierra can be used by to locate wet lands, estuaries, and other
environmentally sensitive features. It can also be used to locate flood planes, avalanche courses and
other dangerous land features.

1.1.2 System Requirements

OpenGL. Estierra uses OpenGL to display the 3D surface terrain models. Therefore, your computer
must have OpenGl installed. Most recently sold computer will have OpenGL installed. A generic
version of OpenGL comes with Windows. More advanced versions come with video cards. Since
most computers these days come with powerful video cards, most computer have the latest and most
powerful versions of OpenGL. 

Win 98. The program has been tested under Win98 and it does run. However, the program puts
heavy demand on memory and you may encounter problems in some situations because Win98 has
problems with memory bigger than 500-megabytes.

Win 2000, XP, Vista and Win7. Win 2000, XP, Vista and Win7 should run Estierra without any
problems.

1.1.3 Hardware Requirements

Estierra puts a heavy load on the computer when it draws images. For this reason, Estierra will work
better with a powerful computer. You can get acceptable results with an old and slow 90 MHz
Pentium with 64 Meg of memory and an ordinary video card. However, with large terrain models, the
animation speed will be slow and the images will take a long time to load. For this reason, a faster
computer is better. A 1-Ghz CPU with 250 megabytes of memory would be considered a minimum
system for serious work. Modern multi-core processors with 1-gigabyte of memory or more is
recommended 

Video Cards. A fast video card can make a big difference in speed. For example, some of the newer
accelerated video cards can run as much 50 times faster than an old, no accelerated card. Currently,
the fastest video cards are made by NVidia and ATI. 

1.1.4 Overview

DEM Files. Estierra works by reading Digital Elevation Model files (DEM) and converting them into
three-dimensional models of the earth’s surface. DEM files contain a grid of numbers that represent
the elevations of points on the earth.

Meshes. Estierra takes the points from a DEM file and converts them into a series of rectangles
called a "mesh." The mesh shows the shape of the land surface.
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Shading and Highlighting. The face of each rectangle is then filled in with a solid color and shaded
according to how the light would reflect off the surface. This gives the surface a three-dimensional
appearance, with shadows conforming to direction the "sun." By moving the "sun" you can produce
different patterns of shadow that can reveal hidden detail.

Smoothing. Finally, the mesh is smoothed to give it a more natural appearance. Once the mesh has
been smoothed, it can be colored, highlighted and overlaid in a variety of ways.

Coloring. The surface of the mesh can be colored and highlighted in a variety of ways to make it
easier to see terrain features. For example, the mesh can be colored by depth to make easier to see
altitude-related information. You can also color by the steepness of the slope. This makes it easy to
see slopes that are likely to avalanche or slide. It also allows you find watercourses and wet lands
that might not be visible by other methods.

Overlays. The mesh can also be overlaid with any image, such as a topographic map, geological
map or aerial photograph. The image is stretched, like a rubber sheet, to conform to the terrain. This
gives it an extremely realistic representation of the topography.
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Animations. The terrain image can be manipulated in real-time using the mouse and tool bar
buttons. On fast a computer you can rotate, pan and zoom the image at a rate of hundreds of frames
per second. You can even fly over and through the terrain using your mouse. Finally, you save your
"flights" over the terrain as Windows movie files (AVI).

1.1.5 Getting Started

After Estierra is installed, there will be a Estierra icon on the Windows Desktop. You can run
Estierra by double clicking on the icon.

Testing. If your are running the program for the first time, it is probably useful to test the program to
make sure that your computer and your video drivers are working correctly. The easiest way to do
this is bring up the Test Object and experiment with the features of the 3D Editor . This will make it
easier to understand what is happening when you work with more complicated 3D objects. 

Creating A Terrain Model. Once you have a basic familiarity with the way the program works, try
loading a standard DEM File. DEM files are available for download from a number web sites. For
complete information on getting DEM files, click here. To build a terrain from one of these DEM files,
follow the instructions found here: Terrain Building.

1.1.6 Startup Problems

When you start Estierra, it initializes the OpenGL drivers in your system. If there are any problems
with the initialization process, the program will display an error message, and in some cases abort.
Here are detailed explanations of the causes of this problem:

 Display Drivers. Every video card has special software that provides an interface between Windows
and the card. These programs are called “drivers.” Sometime these drivers have bugs in them that
cause errors when Estierra tries to use OpenGL. In fact, it is fairly common that the driver for a newly
release video cards will have bugs. These bugs often get fixed in later updates. For this reason, if you
are experiencing an unexplained problem with Estierra or your video card in general, you may want
to download the latest driver. They are usually available at the web page of the card manufacturer.
Drivers for older video cards can be found at web pages that specialize in archiving old drivers.

1.1.7 Test Objects

Estierra allows you to create some simple
3D geometrical objects to experiment with.
This makes it easy to test the program and
verify that that your video card and drivers
are working properly. To create test
objects, select the "File|Test Objects"
option from the menu bar. You then
choose either the "Soccer Ball" or the
"Torus." 

Once the test object has been displayed,
experimenting with the controls on the "3D
Editor" will teach you how to maneuver in
the 3D world.
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1.2 Building Terrains

The main purpose of Estierra is build 3D terrain models from DEM files. In the simplest cases, it only
takes three mouse clicks to create a terrain model.

You build terrains by opening a DEM file and then editing the data to get exactly the terrain you want
and the image you want. You do this by moving through four editors which help you refine and
enhance the data. Each Editor is reached selecting the proper tab at the top of the screen. 

Here is detailed description of each page and each step:

Loading A File.
The DEM Reader Page
Topo Editor Page
3D Editor Page
Overlay Editor

1.2.1 Loading A File

The first step in building a terrain is loading a DEM file. You do this by selecting the "File -> Open
DEM File" option from the menu bar.

File Types. There are two types of DEM files, the old style DEM files which has the extension "DEM,"
and the new SDTS type which as the extension "DDF." You can choose either type by changing the
"File Type" in the Open Dialog.

To find and load the old-style DEM
files, set the "Files of Type" option to
DEM data as shown to the right.

To find and load the new SDTS DEM
files, set the "Files of Type" option to
STDS CEL file as shown to the right.

After the file loads, you will be taken to the DEM Reader Page, where the data will be displayed in
preparation for editing and converting into three-dimensional terrain models.

1.2.2 DEM Reader Overview

The DEM Reader Page allows you view and select elevation data before you convert it to a 3D
object. Here is detailed information about working with the DEM Reader:
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The DEM Reader Page
DEM Tool Bar

DEM Display Modes
DEM Header Info

1.2.2.1 The DEM Reader Page

The first page in Estierra is the DEM Reader page. This page is displayed by selecting the tab
labeled “DEM Reader” at the top of the Estierra window. The DEM Reader page displays an
overview of the DEM data once it has been read into Estierra. 
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Reading DEMs. The first
step in the process of
generating a terrain model
is to read the DEM file
into Estierra. To read a
file, just select "File|Open
DEM File" from the menu
bar. After you have
selected a file, you will be
presented with a window
that allows you to select
the Display Mode you
want. You can also view
a report about the
contents of the DEM File.

Displaying DEM Data.
These files are very large,
(they can contain as many
as 1.5 million points) and
as a result, depending on
the speed of your
computer, it can take 15
to 30 seconds to display
the file. As the file is read,
you will see the screen
being painted one stripe at
a time. You will also see a
bar displaying the
progress of reading the
file.
Examining The Data. After the terrain has been displayed, you can examine the terrain in detail.
There are several tools to help you. First, the scroll bars at the bottom and side of the image allow
you to scroll parts of the image into view. As you scroll the coordinates of the corners of the map are
display at the corners of the image. Also, the coordinates of the mouse cursor are displayed at the
bottom of the screen. Coordinates will be displayed in longitude and latitude for one-degree maps
and UTM for the 7.5-minute maps.

Manipulating The Data. You can manipulate and select the data displayed using tools on the DEM
Tool Bar. 

Selecting Terrain. DEM files contain a large number of points and it is often useful to select a
subsection of data for rendering in 3D. As a result, Estierra allows you to use part or all of the DEM
data for conversion to a 3D model.

Selection Box. Estierra uses a “Selection Box” to
choose part or all of the DEM data for 3D
rendering. When you first load the DEM data, all
the data will be enclosed a box that appears around
the border of the data. You can move the box by 
clicking in the  middle of the box and dragging the
mouse cursor.  This will move the box. Dragging
the corners will expand or contract the box. You
can reset the box so it encloses all the data by
clicking on the “Reset Button” that appears on the 
DEM Tool Bar.
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Further Refinement. Once you are satisfied with the area you have selected, press the “Edit” button.
The program will then switch to the Topo Editor page for further refinement of your data choice.

1.2.2.2 DEM Tool Bar

The DEM Tool bar contains several buttons that control the display on the DEM Reader Page. Here is
a detailed description of each button
:

Redraw Button. The Redraw Button causes the program to re-read the DEM and re-display the DEM
map. This allows you to make changes to the display mode and view the changes.

Reset Box Button. Pressing this button sets the selection box so it encloses all of the DEM data
displayed on the DEM Reader Page. 

Edit Button. Pressing this button copies the currently selected terrain to the Topo Editor where you
can do very precise editing of the terrain.

Terrain Status. This item displays any error that may have been detected while reading the DEM
file.

1.2.2.3 DEM Display Modes

The program can display the DEM file data using three basic modes. When you open a new file, the
program presents a dialog box that allows you to set the display options. If you already have a file
open, you can change the display mode by selecting "DEM|Plot Options" from the menu bar. Once
you have changed the display options, press the Redraw Button on the DEM Tool Bar to view the
changes.

1. Color By Elevation. In this mode, the
program colors each part of the map a
different color depending on the
elevation. The bottoms of valleys are
colored blues, and purples, the tops of
peaks are colored red, gray and white.
There are a total of 15 colors used. If you
select the "Dithering", option the program
will used mix adjacent colors giving a
total of 29 colors. This increases the
resolution of small terrain details, but the
edges of lines can be fuzzy. 

2. Shaded Relief. In this mode, the
program displays the terrain as if it were
illuminated by the sun. The light, dark
and gray areas show the rise and fall of
the terrain. The images look very much
like aerial photographs. This is the most
detailed method of viewing the terrain,
although some feature will be invisible if
the sun is coming from the wrong angle.
Also, in very flat terrain, there may not be
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enough relief to get a clear image.
3. Topographic Contours. This mode connects lines of equal elevation in the same way as a
normal topographic map. You have control over the contour interval. This is fastest mode for
generating a map. 

To compensate for variation in the terrain and the configuration of terrain features, the program
allows you to set the contrast and sun angle. The contrast setting controls how sensitive the program
is to small variations in the terrain. If the contrast value is high, the small variations in terrain will
cause large changes between black and white. If the contrast is low, large changes are required to
produce black or white areas. High contrast is most useful in flat areas, low contrast in rugged, steep
terrain. 

The sun angle controls the direction from which the simulated sun illuminates the ground. This is
useful for visualizing features that are oriented in a certain direction. For example, if there is a cliff
running east and west and the sun comes from the east, the cliff will be invisible. Normally, you want
the sun angle to be at right angles to the feature. Also, be careful of southern sun angle. In spite of
the fact the in nature, the sun usually comes from the south, setting the sun angle to south creates
unusual effects. This is because the eye is used to seeing things illuminated from above. If the sun
angle is from the south, the terrain may seem to reverse itself, with the mountains going down and
the valleys going up. 

You can combine some of the modes to get more details. For example, you can combine color-by-
elevation and contours. (This is the default mode.) At this time, you cannot combine color and shaded
relief. Also, you can these options on the fly while the image is being drawn. The map will have
vertical strips with different attributes so you can compare the effect.

1.2.2.4 DEM Header Info

Each DEM file contains a header, which holds detailed information about the file. You can view this
information by selecting "DEM|DEM Info" option from the menu bar. Here is an explanation of each
of the header items:

Map Name. This item gives a description
of the file. It usually contains the name of
the quadrangle and some information
about its location. If the file has been
converted from another format, there
may be notes on the conversion here. 

Level Code. This information describes
the quality of the data in the DEM file.
Level 1 represents raw data where only
gross blunders have been removed.
Level 2 represents data where random
errors have been removed and the data
has been smoothed for consistency.
Level 3 represents data that has been
edited to insure positional accuracy
relative to the points.

Pattern. This item specifies the pattern of the data. Code 1 represents regular data, Code 2
represents random data. 

Ground Ref. This item decries which coordinate system is used to locate the points. Code 0
represents Longitude/Latitude coordinates. Code 1 represents UTM coordinates. Code 2 represents
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State Plane coordinates. 

Zone. If the Ground Reference is UTM, this item holds the UTM Zone. 

Projection. This item gives UTM projection parameters. Refer to USGS Circular 895-B for further
information. 

Ground Units. This item represents the units for measurements in the file. Code 0 indicates radians,
Code 1 indicates feet, Code 2 indicates meters, and Code 3 represents arc-seconds. 

Elevation Units. This item indicates the measurement units used to represent the elevation of the
points. Code 1 indicates feet and Code 2 indicates meters. 

Poly Sides. This item indicates the number of sides of map. The number is usually four. 

Corners. These items give the locations of the each of the corners of the map. 

Min,Max Elevation. These items give the value of the highest and lowest point on the map. 

Angle. This item shows how the map is rotated relative to geographic coordinates. Normally, this
value is zero. 

Accuracy. This item specifies the accuracy of the map. A value of 0 indicates that the accuracy is
unknown. A value of 1 indicates that accuracy is specified at the end of the file. Refer to USGS
Circular 895-B for further information. 

Resolution. The three values in this item specify the resolution for the X, Y, and Z portions of the
map respectively. For one-degree maps, this value is usually 3 arc-seconds. For 7.5-minute maps,
the value is usually 30 meters. 

Rows,Cols. This number specifies the number of rows and columns in the map. Normally, the row’s
value is set to one, so it is only the columns-value has meaning.

1.2.3 Topo Edtior Overview

The Topo Editor allows you to make further refinements on the elevation data you have selected to
be converted into a 3D image. Here is detailed information about the Topo Editor:

Overview
Topo Editor Page
Conversion Settings

Tools
Data Filter

Manual Data Entry
Edit Grid
Entry Grid Controls
Entering Data
Saving and Loading Data

Synthesizing Data
Generating Data From A Topo Map
Importing Data
Elevation File Format

1.2.3.1 Topo Editor Page

The Topo Editor allows you to trim and refine your choice of terrain to model. To display the editor
simply select the “Topo Editor” tab at the top of the Estierra window.
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Topo
Display.
The Topo
Editor
displays
the terrain
as
topographi
c contours,
but unlike 
the DEM
Reader
Page, it
has the
ability to
infinitely
zoom and
draw
contour
lines
between
elevation
points.
This allows
you to
more
accurately
trim and
refine you
the terrain
you select.

Display
Options.
The Topo
Editor
gives you
control
over
several
aspects of
the display.
Here is a
detailed
description
of each
option:

1.
Ma
rk
Po
int
s.
Thi
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3. Auto Update. When this option is enabled, the program automatically updates the display
every time you make a change. If the computer is slow or you have lots of contour lines, the
display may take several seconds to update. Turning off the option may speed up making
changes to the display. With this option off, you can update the screen by pressing the
“Update” button described below. 

4. Zoom/Spacing. Increasing the zoom factor magnifies the display by increasing the
spacing between points. The Zoom factor is specified as the number of screen pixels
between elevation points. The larger the number the more spacing between points. For
example, if the zoom factor is set to 10, there are 10 pixels between elevation points.

5. Contour Interval. This option controls spacing between contour intervals. For example, if
the interval is set to 200 feet, contour lines will be drawn at even elevation intervals of 200
feet. Decreasing the spacing increases the number of lines and increases the detail that can
be seen.  

6. Update Button. Pressing the Update Button causes the program to redraw the contour
lines in the displays. If you have the Automatic Update mode turned off, pressing the button
will allow you to see the effects of any changes you have made.

Status Bar. The Status Bar at the bottom of the Topo Editor pages displays status information about
the display. Here are detailed descriptions of each status item:

1. Point. This item displays which grid points the mouse cursor is over. Since the mouse can
be between points, the item displays fractions. For example, if the display was 12.5, 12.5, the
cursor would be halfway between the 12th and 13th X and Y points.

2. Size. This item displays the total number of points contained within the display. 
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3. Location. This item displays the geographic location of the cursor. If the DEM file is a one-
degree file, the location will be displayed in longitude and latitude. If the DEM file is a 7.5-
degree file, the location will be displayed in UTM. Note: some DEM’s have inaccurate
longitude/latitude or UTM data associated with them. Thus, you should not rely too heavily on
this information. (The units displayed can be set to either meters or feet in the Environmental
Settings dialog.)

4. Elevation. This item displays the elevation of the cursor. (The units displayed can be set
to either meters or feet in the Environmental Settings dialog.)

Tool Bar. The Tool Bar at the top of the Topo Editor contains several buttons that perform specific
actions on the data represented by the display. Here are detailed descriptions of each button:

1. Clip To Box. If you find that the area you have selected is larger than you wanted, you can trim
data to fit your needs. To trim the data, you need set the clip box to include the part of the terrain you
want. To set the upper left-hand corner of the clip box, select the "Top-Left Box" cursor option. Next,
move the mouse cursor to the upper left corner of the area you want to trim and click. Follow the
same procedure with the lower right corner, selecting the “Lower-Right Box” cursor option. When you
are satisfied that you have enclosed the area you want, click on the "Clip To Box" button. This will
trim the data to the box. (Note: to select a larger area or reset to the original area, you have to go
back to DEM Reader Page and reselect the base area.)

2. Edit Grid.  Pressing this button takes you to the Edit Grid. The Edit Grid allows you to manually
edit or enter elevation data. It is useful if you do not have a DEM file for the area you are working
with. It also allows you to manually remove defects from the data.

3. Filter. Pressing this button takes you the Data Filter tool. The Data Filter allows you to remove
defects from the data such seams and noise. 

4. Convert 3D. Once you are satisfied with the data you have selected, you can convert it to a 3D
model. You do this by pressing the Convert 3D button. This will take you to the Terrain Mesh
Conversion Settings dialog and finally to the 3D Editor page.

1.2.3.2 Terrain Mesh Conversion Settings

When you press the Convert 3D Button on the Topo Editor page, the program will begin the process
of converting the selected data to a terrain model. Before the program does the actual conversion, it
will display the Terrain Conversion Settings window. This window allows you to set options that
control the way the terrain will be converted. Here is a detailed description of each option:
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Vertical Exaggeration. This
option can be used to
increase or decrease the
vertical aspect of the terrain.
For example, if the Vertical
Exaggeration is set to two,
the elevation of each point
will be twice as high as the
actual elevation. This makes
it easier to see small changes
in the terrain. It is particularly
useful when dealing with
relatively flat terrain. Also,
since people are relatively
small compared to terrain
features, terrains may seem
flat when viewed on a
computer. As a result,
increasing the exaggeration
can make the terrain models
seem more realistic

Maximum Polygons. Most graphics cards and drivers have a limit to the number of polygons that
can be displayed. This is limit is typically around 64,000, although on some computers it can be less
than 32,000. For this reason, Estierra allows you to set a limit to the number of polygons used to
display the terrain. If the terrain you have selected contains more points than the limit, the program
will reduce the mesh size by a process called “resampling”. The more the program has to reduce the
points, the lower the resolution of terrain model and more fine detail that will be lost. The Resolution
display item described below shows the amount of resolution that will remain after reducing the mesh
size.

Terrain Base Options. Each terrain model has a square “base” that it sits on. This makes it easier to
orient and manipulate the terrain model. You can remove the base by disabling the “Draw Base”
option. You can also control the height of the base adjusting the “Base Height” option. The height is
specified in terms of percentage of the height of the terrain. For example if the Height is set to 10%
and the terrain has an elevation range of 10,000 to 14,000 feet, the base will have a height of 1000
feet.

Polygon Shape. This option controls whether the polygons that form the mesh are rectangles or
triangles. Triangles can create smoother surfaces, but require twice as much memory. For most
purposes, rectangles are the best choice.

Size. The Size display shows the width and height of the mesh that will be created as well as the total
number of points in the mesh. This is based on the area of terrain that you selected in the DEM
Reader Page and the Topo Editor Page. The larger the area selected, the more points in the mesh.

Faces, Vertices and Normals. A Terrain Mesh consists of Faces, Vertices (points) and Normals.
This item display a count of number of these components needed to construct the mesh. The larger
the mesh the greater the numbers for each item. You can increase or decrease these numbers by
adjusting the Maximum Polygons option described above.

Memory Required/Available. This option displays the amount of memory required by the terrain and
the amount of memory available on the computer. Generally speaking, if the terrain size exceeds the
available memory, the program will run very slowly or stop working all together.



Estierra  Help22

Copyright Fountain Computer Products 2010

Resolution. When the mesh size exceed the Maximum Polygons option described above, the
program reduces the number of polygons in the mesh. This reduces the resolution and some fine
details in the terrain will be lost. This item displays the percentage of resolution. A 50% resolution
would indicate that half of the original resolution has been lost. One option if you need high
resolution, is to select a smaller area to work with.

Process File Button. When you press this button, the program will begin processing the mesh
according to the parameter you have specified. Depending on the speed of your computer, this may
take up to 30 seconds. Once the mesh has been processed, the program will switch to the3D Edtior
Page and will display the terrain model.

1.2.3.3 Data Filter

DEM files can have various kinds of anomalies in them. These are usually caused by errors in data
generating process. For example, there can be seams in the data where two pieces of surface terrain
have been merged together. Also, you can have periodic data, such as sine waves, superimposed on
the terrain giving it a corrugated appearance. The Data Filter options allow you to remove some of
the artifacts.

To access the Filter Options, press the Filter Button on the Topo Editor page. This will display the
Filter Window. Here is a complete description of the filter tools:

Direction. One of the characteristics
of data anomalies is that they usually
occur along one axis. For example, a
seam will usually occur along a single
row or column in the data. As a result,
you have a choice of analyzing and
filtering the data in the east-west or
north-south directions. 

The Graph. The Graph allows you to
visualize anomalies in the data. The
graph always display anomalies along
the axis specified by the Direction
option described above.

The program looks for defects in the
data by looking for patterns. For
example, it would be very unusual for
all the elevations to jump up on the
same row of data. This would probably
indicate a seam in the data. As a
result, Estierra looks for any changes
that occur across all the rows or all the
columns at the same. It then graphs
the result. Anomalies show up in the
graph as sudden shift in the line of the
graph. 

Smooth Data Button. Pressing this button causes the program to smooth the data in the specified
direction. Depending on the severity of the anomalies, it may require several passes before the
anomalies will be removed.   
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1.2.3.4 Edit Grid

The Edit Grid allows you edit or enter elevation data. For example, if you are unable to locate a DEM
file for a particular area, you can manually enter data from a topographic map. You can also repair
small defects in DEM files using the Edit Grid. To access the Edit Grid, go to the Topo Editor Page
and press the Edit Grid button.

Here are detailed descriptions of how to use the Grid:

The Entry Grid
Entry Grid Controls
Loading/Saving Data
Elevation Data Format
Generating Data From A Topo Map
Importing Other Data Formats

1.2.3.4.1  The Entry Grid

The Entry Grid.  A DEM file consists of an array of points that correspond to the elevations of some
area on the surface of the earth. The Entry Grid displays these points and allows you to enter or edit
them. Cells in the upper left-hand corner of the grid correspond to the northwest corner of the terrain.
Likewise, cells in the lower right corner of the grid correspond to the southeast corner of the terrain.

To enter points, you simply click on a particular cell and type a number. Hitting Enter or Tab will
move you to the next cell to the right. When you are done entering or editing data, press the OK
button at the bottom of the window and the new data will be used by the Topo Editor.
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1.2.3.4.2  Entry Grid Controls

There are several controls that allow you to manipulate the Entry Grid. Here is a detailed description
of each:

Copy and Paste Buttons. These buttons allow you exchange data with other programs via that
Windows Clipboard. If you press the Copy Button, the program copies all the data in the Grid into the
Windows Clipboard. The data in the Clipboard will be formatted so that it can be pasted directly into a
spreadsheet such as Excel. (The data is formatted so each row is on a separate line ending with a
Carriage Return and each data item separated with a Tab character.)

The Paste Button copies data from the Windows Clipboard into the Grid. The program expects each
row to be terminated with Carriage Return character and each data item to be separated with any
non-numeric characters such as a comma, space or tab.

Clear Button. The Clear Button deletes all data from the Grid and empties all cells.

East/North Resolution. Each point in an elevation grid is spaced a specific distance apart. For
example, a typical 7.5-minute DEM file will have data points spaced every 90 feet (30 meters).
Estierra uses this information to scale the terrain models it displays. Normally, Estierra will read this
information from the DEM file, however if you are manually entering data, you will need to specify the
spacing yourself.  Since some DEM files have a different spacing in the East-West direction than in
the North-South direction, there are two boxes, one for each direction. To set the resolution, simply
enter the values in East and North Resolution Boxes. The units used are set by the Environmental
Options.

Update Contour Intervals. When this option is enabled, the program automatically adjusts the
contour interval when you return the Topo Editor. This is useful when you have made changes to the
Grid data that effects the elevation range. On the other hand, you may want to disable this option if
you have made changes to the contour interval that you want to preserve. 
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1.2.3.4.3  Saving and Loading Grid Data

Load and Save Buttons. These buttons allow you to save elevation data in a simplified format. This
is useful for saving manually entered data or when you want to save a subsection of a full DEM file.
To save the data in the Grid, simply press the Save button and select a filename. Likewise, to Load
data, press the Load Button and then select a file.

(For programmers and sophisticated users, click here for the detailed information about the file
format.)

1.2.3.4.3.1  Elevation File Format

Data Format. In some instances, it may be useful for a programmer to create his or her own
elevation files or to read the elevation data into another program. For this reason, here is a complete
description of the data format:

1. ASCII. All data is represented as simple ASCII text. Numbers can be in any format including
floating point. Arguments are separated by any non-numeric characters such as commas, spaces or
tabs. The default separator is a comma. The data is generally organized in to lines separated by a
carriage return and line feed pair.

2. Meters. All measurement units are in meters.

3. Data Items. The main items of the file are presented on separate lines. Here is a complete
description of each data item in the file: 

A. Grid Rows and Columns. This item specifies the number of Row and Columns in the
elevation data. It consists of two integer values.
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B. Resolution. This item consists of two floating point numbers that represent the spacing, in
meters between each point in the data. The first argument is the West-East spacing. The
second argument is the North-South spacing.

C. Location. This item represents the UTM location of the northwest corner of the elevation
grid. The individual arguments are two floating point numbers representing the  East and
North Offset, and on integer representing the UTM Zone.  

4. Sample Data. Here is sample data for a typical elevation file:

3,3 - Columns and Rows
30,30 - Resolution
0,0,0 - Location – East, North, Zone
2902.9,2891.0,2879.1 - Row 1
2909.9,2899.9,2888.9 - Row 2
2915.1,2906.0,2897.1 - Row 3

1.2.3.4.4  Generating Data From A Topo Map

In some instances, you may not be able to find DEM files for a particular area. Since topographic
maps are more readily available than DEM files, one way to deal with this problem is to manually
generate the data by reading it from a topographic map. Although the process can be very tedious, it
is a very viable method of creating terrains. Here is a set of step-by-step procedures for generating
data from topo maps:  

1. Select A Map. Locate a topo map of the area you are working. Normally, you will want to use high-
resolution maps to such as 7.5-minute quadrangles to get sufficient detail. 

2. Select A Grid Spacing. Grid spacing is the distance between points. The closer the spacing the
greater the resolution. However, it also means more points, which will take more time to enter.
Spacing of 100 to 500 feet is typical. 

3. Layout A Grid. Using the scale bar on the topographic map and a ruler, lay out a grid of evenly-
spaced points on the map covering the area you want to model. You can use a piece of mylar, tracing
paper or other clear media so you don't mark up the map. Your grid should be aligned with the map’s
grid system so that the rows and columns run along west-east and north south lines. Although it is not
essential, you may want to align one corner of the grid to a specific UTM location.

4. Read The Evelvations. Using the topographic contour lines, write down the elevation of each
point on grid. If a grid point falls between topographic lines, you can estimate the elevation. For
example, if a point fall 3/4 of the way between the 100 and 200 foot contour, the elevation would be
175 feet. 

5. Enter The Data. Once you have gathered the data points, you should enter them into the Edit Grid
. As you enter the data, be sure to periodically save the data so you will not accidentally lose your
work.

1.2.3.4.5  Importing Data

There are many different data format that are used for elevation model files. The DEM formats
supported by Estierra are U.S. standards. Other standards are used outside the United States. Some
of this data can be easily imported into Estierra using the Paste option in the Edit Grid.

If you can find a way to get the data into a spreadsheet such as Excel, the data can be copied from
the spreadsheet and pasted into Estierra. Excel has import features that allow you convert various
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common data formats and bring them into a spreadsheet. It is also possible to use a good text editor
to reformat data so it can be pasted into Estierra.

1.2.4 3D Editor Overview

The 3D Editor displays and manipulates the 3D image of the terrain. Here is detailed information
about using the 3D Editor:

Tools
Tool Bar Controls
Materials
Lights
The Status Bar

Movements
Mouse Movements
Flying Through an Image

Special Features
Creating Movies

1.2.4.1 Tool Bar Controls

There are 18 items on the 3D Editor tool bar. These items allow you to control and manipulate the 3D
images.
 

1. Zoom In/Out Buttons. These two buttons make the image bigger or smaller. They work by scaling
the objects view larger or smaller. This is different from moving the camera in and out, because the
zoom buttons actually makes the object bigger. This can be very useful when you want to get close to
an object without seeing inside it. 

2. Pan Buttons. The Pan Buttons move the objects in the scene right, left, up and down. Each button
has an arrow that identifies the direction the object will move.

4. Yaw and Pitch Buttons. These buttons rotate the image. The yaw buttons rotate the image
around the vertical axis. Pitch button rotates the image toward and away from the person looking at
the image. 

5. Increment Control. This controls the percentage of change that happens when each button is
pressed. Increasing the number causes larger changes. Decreasing the number causes smaller
changes. For example, if the value is 10, each time you press the Zoom button, the image expands
by 10%. 

6. Animate and Stop Buttons. These two buttons allow you animate the image on the screen. If you
click on the "Animation" button and drag the object with the left mouse button, the object will continue
to rotate after you have released the mouse button. The rotation will continue until you press the
"Stop" button or release the "Animation" button.

7. Reset Scale Button. This button resets the pans, zooms and rotates to their original values.

8. Start/Stop Capture Button. This starts or stops the AVI Movie capture option. 

8. Shading. This option controls how the terrain surface is displayed. In Wire Mode, the terrain is
displayed a wire skeleton of the surface. In Flat Mode, the terrain is displayed as a series of flat
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facets. Finally in Smooth Mode, the terrain is displayed as smoothed surface.

Wire Mode Flat Mode Smooth Mode

 

1.2.4.2 3D Status Bar

The 3D Editor’s status bar sits along the bottom of the page. It displays status information about the
3D image. Here is a detailed description of each status item:

Position. This item displays the position of the terrain model on the screen in X, Y, and Z values.
The X-value is the left and right position relative to the viewing screen. The Y-value is the up and
down position relative to the screen and the Z-value is the position in and out of the screen.

Rotation. This item displays the rotation of the terrain model on the screen. The first value displays
the Yaw rotation, which is rotation around the vertical axis. The second item displays the Pitch
rotation, which is rotation around the horizontal axis. The third item displays the Roll rotation, which is
rotation around the Z-axis or the axis running toward the user’s eye.

Tris. This items displays the total number of triangles contained in the current scene.

TPS. This item displays the number of triangles being drawn each second. It is a measure of the
speed of the computer and display. A good graphics card can hit display rates of well over 1,000,000
triangles per second.

FPS. This item displays the number of frames being displayed each second. It is a measure of the
speed of the computer and display. The value will depend on number of triangles in the scene and
the speed of the computer. A fast video card can display rates of over 100 frames per second even
with a large number of triangles.

Display Speed. The speed of the display is effected by the speed of the computer, the speed of the
video card and the properties of the object that is being displayed. For example, if the object has a
large number of e polygons, the speed will decrease. Also, enabling special features such as
texturing and shading can slow the frame rate with some video cards. Also, zooming into an object
increases the frame rate because the program has to display fewer polygons. Finally, the frame rate
can be effected by the video mode you are using. With some cards, displaying more colors and more
resolution can slow the frame rate. However, the newest video cards are unaffected by colors and
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resolution.

1.2.4.3 Creating Movies

Estierra has the ability to convert your terrain viewing sessions in to movies. In other words, Estierra
can capture everything that happens on the 3D Page and save it as a Windows AVI file. AVI files can
be played by the Windows Media Player and they can also be edited by the movie editing program
such as “Windows Movie Maker”, which comes with Windows XP. Here the steps necessary for
creating a movie:

1. Setting Options. There are several options that control
the way a movie is captured and saved. To set them select
“Options|Capture Options” item from the menu bar. The
follow settings are available:

Frames Per Sec. This is the speed at which the
finished AVI file will play back. The faster the
speed, the smoother the animation. However,
faster frame rates will make bigger files for the
same elapsed time.

Compression. This option controls how
compression is used to create the AVI files. More
compression yields smaller files, but the image
quality will decrease and the fine details in the
images will be lost. 

Limit Movie Size. Since movie files can consume hundreds of megabytes of disk space, this
option allows you to limit your movie’s size. 

Max Frames. This option sets the maximum number of frames for the program to capture.
The program will automatically stop capturing when it reaches this limit if the "Limit Movie
Size” option is enabled. 

Time. This item displays the run time of the movie at the specified limit. Adjusting the
“Frames Per Sec” and “Max Frames” option will change this value.  

2. Arming Capture. The next step in creating is movie is to “Arm” the capture mechanism. This does
not actually start the capture process, it simply get everything ready so the process can be initiated
quickly. To Arm Estierra, select the “Edit|Arm AVI Capture” option from the menu bar. The program
will then prompt you for the filename that will be used to save the image.

3. Begin Capturing. Once Estierra has been armed, the Start/Stop Capture button on the 3D Page
Tool Bar will be activated. Pressing this button will start the capture process. You may notice that
animation will slow down. This is because the program working extra hard both displaying and
capturing the information. Pressing the button a second time will stop the animation program and
save the information to the AVI file. If you are working in Windows you can double click on the file
and the Windows Media Player should begin showing you the movie.

1.2.4.4 Mouse Movements

The easiest way to manipulate a 3D Model is using the mouse. Here are detailed descriptions of all
the mouse movement options:
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1. Left Mouse. Holding down the left mouse button and dragging allows you to rotate the object
around two axes. Moving the cursor left or right rotates the 3D object around the vertical or Yaw axis.
Moving the mouse cursor up and down rotates the object around X or Pitch axis.

2. Right Mouse. Holding down the right mouse button and dragging allows you to move the object
left, right, up and down.

3. Middle Button or Left/Right Together.  Finally, you can zoom in or out using the middle mouse
button. If you don’t have a middle button, you can get the same effect by holding down the left and
right buttons simultaneously. Moving the cursor up the screen causes the program to zoom in on the
object and makes the object appear bigger. Likewise, moving the cursor down causes the program to
zoom out. To give the effect of flying through the scene, moving the mouse left and right while
zooming, causes the scene to move in the opposite direction.

1.2.4.5 Flying Through an Image

One of the more interesting effects that Extierra is capable of is flying above and through the terrain. 
Estierra views the world through an imaginary "camera." Flying through the image involves moving
the camera through the scene. This different from the normal pan, zoom and rotate operation which
are accomplished by moving the image rather than the camera. 

Flying. Flying can be done using the middle mouse button If you don't have a middle mouse button,
use the left and right buttons together. With middle button down (or left and right together), moving
the cursor up the screen "flys" the camera closer to the image. Likewise, moving the cursor down the
screen moves the camera further from the image. Moving the cursor left or right moves the camera
left and right moves the camera left and right. These motions give the impression flying around the
objects in the scene. 

Penetrating Objects. As you fly very close to an object, you will notice that parts of the object will
seem to disappear. This is because parts of the object are protruding through the imaginary lens of
the camera. You can minimize this effect, using the "Plus" button on the tool bar. This scales the
object larger so that you have the appearance of moving closer without parts disappearing. 

Remember that you can reposition and rotate the object on the screen using the other mouse buttons.
Once, you get good at manipulating the mouse buttons, you can easily fly around and through any
object.

1.2.5 3D Options

There are several sets of options that control the way 3D objects such as terrains are displayed. Here
is a detailed list of the options:

Scene Settings
Materials.
Lighting.

1.2.5.1 Scene Settings

The Scene Setting option allows you to set general options about the scene background. To access
Scene Settings, select the “Options|Scene Settings” from the menu bar. There are two pages in
Scene Settings window. Here is a complete description of each one:

General Page.
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Background Color. The Background
Color is the color of the screen behind
the objects. The program defaults to a
dark gray background color. This can
make it difficult to see dark objects.
For dark objects, you may wish to
choose a lighter background color. 

Background Image. You can also
load a bitmap image to use as the
background to a scene. For example,
you display an image of clouds or rock
formations as a background to the
image. The image can be an ordinary
Windows bitmap or BMP file. 
It can also be a Windows "Portable Pixel Map" or PPM file. The dimensions of the image must be a
power of two. For example, 64x64, 128x64, 32x128, etc

Fog. This option allows you to create a
fog effect. When the fog effect is
enabled, parts of the image that are
further away, appear lighter as though
shrouded in fog. (Note: to get the full
fog effect, the Background Color
should be set to white.) Here is a
detailed description of the fog options:

Start. This controls the
distance from the view port
that the fog bank starts. If the
number is negative, the fog
bank starts before view port.

End.  This controls the point in the scene where the fog bank become impenetrable and
beyond which you can’t see. The fog distributed between the start and end points. The more
space between there is between the start and end, the more gradual the fog thickens. If you
set the Start and End points to the same value, it will produce an abrupt, impenetrable fog
back.

Fog Mode. This mode controls how rapidly the fog density builds up. In Linear mode the fog
density goes up linear with distance. In Exponential Mode, the density goes up exponentially.
Finally, in Exponential Squared mode the density goes up exponentially by the squared
distance. Note: many video cards do not support these modes.

Density. This option controls the density of the fog. The range of values is between 0 and 1.
Larger values increase the density. Smaller values decrease it. Note: many video cards do
not support these modes.
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1.2.5.2 Materials

In the real world, all objects reflect light in different ways depending on the characteristics of the
materials they are made of. For example, a shiny metal object reflects most the light that falls on it,
while a piece of cloth defuses the light that falls on it. 

To access the Materials Options, select the "Options -> Materials" item from the menu bar.

The Materials Dialog Box is divided into two pages. Here is a detailed description of each page:

Object Properties
Transparency.

1.2.5.2.1  Materials Properties

The Materials Page contains four sections. Here is a detailed description of each one:

Select Object. Each object in the scene
can separate and distinct material
properties. For this reason you have to
choose which objects the changes you
make will apply to.

The control displays a list of all objects
the may be displayed in the 3D scene.
To selection one or more objects, check
the box to the left of the item.

Emission. This options controls how
much light comes from inside the object.
The more light that comes from inside
the object the more the object appears
to glow. The Red, Green and Blue
values control the color of the glow.

Shininess. This option controls how well
reflects off the object. The more light
that is reflected off the object the shinier
and more metallic the object appears.
D. Specular. When light reflects off an object, there is often shiny spot where the reflection appears
brightest. The Specular option controls the size of the reflected bright spot.

1.2.5.2.2  Materials Transparency

This option allows you to control the details of the transparency. When the Transparent option is
enabled, the selected objects in the scene can be made transparent in various ways. Here is a
description of the details of the controls:
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Transparency. This slider controls the level
of transparency of the selected objects.

Blend Background. When this option is
enabled, the colors of background objects
are blended with those in the foreground. In
some instances, this creates a more
pleasing and realistic transparency.

Depth Check. When this option is enabled,
the program applies the transparency in the
order of the furthest object first and closest
object last. In some cases, this makes the
transparency more realistic.

User. When this option is enabled, the
transparency is controlled by the "Source"
and "Destination" setting at the bottom of
the window.

Source/Destination Pixels. These options control the way pixels are combined to create
transparency. The Source Pixels are pixels in the the image that in the background. The Destination
Pixels are pixels from objects that are in the foreground. The choices control how those pixels are
combined. Since there a lots of combinations and it get complex, it is best just to experiment with
different combinations to until you get the effects you are looking for.

1.2.5.3 Lighting

These options allows you to control the way scene images are lighted and various properties of those
light. To access these options, select the "Options|Lighting" item from the menu bar. The Lighting
Window consists of two pages. Here is a detailed description of each one:

Individual
Ambient
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1.2.5.3.1  Individual Lights

You can use up to eight individual lights to illuminate the scene. Each light can be have different and
distinct properties.

Light List. The light list appears on the left
side of the Individual Light Page. It shows a
list of all eight lights available for
illuminating the scene. You select a light by
checking the box to the left. Only those
lights that are checked will be modified by
the changes you make.

Light Properties. The right side of the Individual Light Page is divided into three sub-pages which
allow you to change the properties of the selected light or lights. Here is a detailed description of each
page: 

Light Type Page
Light Position Page
Light Color Page

1.2.5.3.1.1  Light Type Page

I. Light Type Page. This pages allows you to set the
light type. 

A. Light Types. Each light can be one of three types.

1.  Point Light. A Point Light is a light projected
on the scene from a single source that radiates in
all directions. It is like a bare light bulb in that it  is
not directional, however, by changing the position
of this light, you can change the way shadows fall
on the scene. You set a Point Light's position on
the "Position Page," described below.

2. Spot Light. A Spot Light, is a light the comes
from a single source but is concentrated into a
single beam like a flash light. At a short distance
from an object in the scene, a spot light projects
small circle of light on the scene. You control a
spot light by setting its position and its direction.
The position is set on the "Position Page," and the
Direction is set on this page. Both options are
described below.
3. Directional. A directional light produces parallel rays of light coming from a certain direction
illuminating the whole scene. A directional light does not have a position but it has a direction
which can be set on this page. Setting the direction is described below.

B. Spot Parameters. This option allows you to set a spot light's parameters. The Direction Option
allows you to set the direction the spot light is pointed. The display shows the East, West, North,
South, Up and Down orientation of the of the light beam. The spot light's beam will be directed along
the North-axis in the display. You drag the E, W, N, S, U and D lines so the spot light beam is
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oriented the way you want. You will be able to see the spot light beam move in the display as you
manipulate the control. (Note, the beam must be pointed directly at an object before you will see it.)

Cutoff. The Cutoff Parameter controls the how far the spot light beam travels before it dissipates.

C. Directional Parameters. This option allows you to set the direction the directional light points. The
display shows the East, West, North, South, Up and Down orientation of the of the light beam. The
directional light's beam will be directed along the North-axis in the display. You drag the E, W, N, S,
U and D lines so the beam is oriented the way you want. You will be able to see the beam move in
the display as you manipulate the control.

1.2.5.3.1.2  Light Position Page

II. Position Page. The Page Allows you to
set the position of a Point Light source or
a Spot Light. The position is controlled by
two graphs that represent the position of
the light. The first graph displays the
position as viewed from the front. The
second displays the position as viewed
from above. The position is represented
by a red dot on each graph. You can move
the position by clicking on a graph and
dragging the red dot to a new location. As
you move the dot, the display will change
showing the effect of the changes in the
scene.
  
Light Position. You can also view and
change the position using X, Y and Z
coordinates with the control that appears
at the bottom of the Position Page.

1.2.5.3.1.3  Light Color Page

III. Color Page. The color page allows you to set the color and other properties of the light. 

A. Diffuse. This control set the Red, Green and
Blue (RGB) color of the Diffuse part of the light.
This is part of the light that appears on non-
shiny parts of the object. 

B. Ambient. Each light can have an ambient
light associated with it. Ambient light is light that
come from all directions like the light that filters
through clouds on a cloudy dya.
This control sets the RGB color of the ambient
light. (This Ambient Light is different from the 
general ambient light for the whole scene.)

C. Specular. Light can reflect off certain parts
of an object more than others. In the real world,
this produces a shiny spot right at the peak of a
rounded surface. This control sets the color of
that shiny spot. 
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D. Attenuation. Light dims as it travels. This control allows you to set how much the light dims.

Constant. This option decreases the light a fixed amount, no matter how far the light travels. You
can use
this to set the basic brightness of the light.

Linear. This option set the level of linear dimming the light has. If the number is zero, the light
doesn't dim with distance. The larger the number the more dimming occurs with distance.

Quadratic. This option set the level of non-linear dimming the light has. Using this option causes the
light to dim slowly at first then more rapidly. This is very similar to the way real light behaves. If the
number is zero, the light doesn't dim with distance. The larger the number the more dimming occurs
with distance.

1.2.5.3.2  Ambient Lights

The Ambient Light Settings controls the amount of light that hits the objects from all directions. It is
similar to the kind of light you have when you have a cloudy day. In other words, there is no single
point where the light comes from and all sides of an objects are equally illuminated. 

Since it comes from all directions, it will be noticeable in places where there is no direct light. As a
result, it tends to control the contrast of the objects. The more ambient light, the less pronounced the
shadows will be.

1.2.6 Overlay Editor Overview

The Overlay Editor allows you to overlay the terrain with aerial photographs, topographic maps and
even specialized maps such as geologic maps. The editor allows you to manually adjust the overlay
image so even maps and photographs that are not geographically registered can be used with 
Estierra.

How It Works. The main purpose of the Overlay Editor is to align and scale the image to match the
terrain. Editor works by drawing contour lines over the surface of the image. These contour lines
correspond to the terrain. You then adjust the position and scale of the contour lines until they align
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with the terrain features. This allows you to precisely align the surface terrain to the image. Here is
detailed information about the using Overlay Editor.

Step-By-Step Procedures
Mouse Contour Adjustment
Overlay Controls
Overlay Status

Overlay Options
Alignment Techniques
Geo-registered Files

1.2.6.1 Overlaying - Step-By-Step Procedures

The Overlay Process. (Note: before you can begin the overlay process, you must create terrain
model.)The Overlay process consists of four steps:

1. Load Image. You begin by loading an image to overlay on your terrain. You do this by pressing
the Load Image Button. This will allow you to load a bitmap image from you computer. The image
can be in bmp, jpeg, jpg, tiff, geotif and drg formats. To make the image compatible with OpenGL,
the image will be resized as it is read. This operation can take several seconds.

After the image has been loaded, the program will display topographic contour lines superimposed
over the image

2.  Adjust Topographic Contours. The next task is to align the topographic lines with the terrain.
You do this using the Mouse to move, size and rotate the contours. You can also do this using the
Move Buttons to move the topo-lines left, right up and down. You can also adjust the scale of the
contours by pressing the Expand Contours and Shrink Contours buttons. Finally, you can rotate the
contour lines to compensate for any rotations in the image. Click here for detailed information on the
alignment process.

3. Overlaying. Once you are satisfied with the alignment between the contours and the image, press
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the Apply Overlay button. The program will then apply the image to your terrain and switch you to
the 3D Model Editor so you can view the results. If you are not happy with the alignment, just repeat
steps 1 and 2 described above.

1.2.6.2 Mouse Contour Adjustments

You can move, resize and rotate the contour lines using the mouse.

1. Moving Contour Lines. Clicking inside the box that holds the contour lines and dragging will
cause the contour lines to move with mouse. This allows you to reposition the contour lines.

2. Resizing/Scaling Contour Lines.
You can resize the the contour box by
clicking on the small blacks boxes in the
corners of the contour area and dragging.
Dragging toward the center shrinks the
contours. Dragging away from the center
expands the contours.

3. Rotating Contour Lines. You can
rotate the contour box by clicking on the
small green circle at the top of the
contour area and dragging in a circular
directions.

1.2.6.3 Overlay Controls

The Overlay Page contains controls that are used to manipulate the contour lines and move them
into alignment with the overlay-image. Here is a detailed description of each control:

Move Buttons. The four Arrow buttons in the
upper-left corner are used to move the contour
lines left, right, up and down. 

Expand/Shrink Buttons. The Plus and Minus
buttons are used to expand and contract the
contour map. In effect, this changes the scale of
the contours and allows you to adjust the size of
the image to match the size of the terrain.

Rotate Buttons. The Rotate Left and Right
buttons rotate the contour lines. This is useful for
aligning the terrain to images and maps that have
rotations in them. Note: Once you rotate the
terrain, the time it takes to draw contour lines will
increase a great deal. For this reason, you
probably want to do your rotations last. Also, it may
help to increase the Contour Interval since the
decreases the number of lines the program has to
draw.
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Contour Interval. When the program draws contour lines on the image, the lines are spaced at even
values of elevation. For example, if the contour interval is set to 100 feet, the each line will drawn at
multiples of 100 such as 100, 200, 300, etc. The smaller the contour interval, the more lines that will
be drawn and the more details you will be able to see. Also, the resolution is limited by the number of
points and accuracy of the DEM file. Generally speaking, values below 40-feet do not increase the
accuracy of the display. Finally, smaller contour interval values increase the time it takes to update
the display, which can be a problem for slower computers.

Invert Image. This option changes all the colors in the image to the opposite values. For example, if
the overlay image is mostly light colors, the image will change to mostly dark colors. This can
increase the contrast between the contour lines and the image and make the lines easier to see.

Hide Contour Lines. This option hides the contour lines. It may be useful at times to hide the
contours so it is easier to see the image and locate features. 

1.2.6.4 Overlay Status Bar

There is a status bar at the bottom of the Overlay Page that displays the status of various Overlay
Controls. Here is a detailed description of each status item:

Mouse. This item displays the position of the mouse cursor in pixels over the image and contour
lines. 

Rotation. This item displays the rotation of contour lines in degrees. You can change these values
using the Rotate button. 

Origin. This item displays the distance between upper left-hand corner of the image and the center of
the terrain. The values displayed in percentage of the image width and negative when the terrain is
moved down or to the right. Thus, the when the terrain is centered on the image, the number will be –
0.50, -0.50.

Scaling. This item displays the scaling between the image and the terrain. Since the terrain is
generally many kilometers wide and the image is relatively small, the scale factors are very small
numbers.

1.2.6.5 Overlay Options

There are several options that control the image and contour lines in Overlay Editor. To access these
options, press the Options Button on the Overlay Page. This will display the Overlay Options window.

The Overlay Options window has three
pages. Here are a detailed descriptions of
each page:

Image Page
Color Page
Contours Page

1.2.6.5.1  Image Page

The Image Page of the Overlay Options window controls qualities of the image that is used to overlay
the terrain.
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A. Sizing Options. Because of limitation in
OpenGL, overlay-images are required to have
sizes that are “powers of two” such as 256, 512,
1024, 2084, etc. For this reason, the program
automatically resizes the image as it is read.
Generally the program picks a size that is a
good compromise between resolution and size.
However, the program also limits the maximum
size of the image to 4096x4096, to save
memory and to speed up operations. The
Sizing Options list offers other sizing options for
the image you are working with. This allows you
vary the resolution and size of the image.

Larger Images. Increasing the size can increase the resolution of the image, however larger images
are slower and take up a lot memory. For example, a 4096x4096 image can take up 67-megabytes of
disk space, memory space and video card memory, which could tax the resources of some
computers and make the terrain files difficult to transmit over the Internet.

Smaller Images. Using a smaller size will decrease the amount of memory used and speed up the
display. However, the smaller images have less detail, especially when the terrain model is viewed
up close.

B. Base Size/Current Size. The Base Size displays the original size of the image on disk. The
current size shows the size of the image that is currently stored in the program’s memory. 

C. Sharpness.  When the program resizes the image, it must make special adjustments to individual
pixels to change the image size. For example, if the image is made bigger, the program must insert
new pixels into the image to increase its size. Likewise, if the image is made smaller, the program
must throw away some pixels in order to decrease its size. The Sharpness option controls the way in
which the pixels are added and removed and this, in turn, effects the sharpness or clarity of the
image. 

Sharp. When this option is set, the lines and the edges of objects will be sharply demarcated,
but some artifacts may appear in light-colored areas.

Medium. This is a good compromise option. With this setting, lines will be slightly softer, but
there will be few artifacts. 

Soft. This option produces virtually no artifacts, but line will be somewhat soft and slightly
blurry.

Apply New Size/Sharpness. Pressing this button applies any size or sharpness changes that you
may have made.

1.2.6.5.2  Overlay Options - Color Page

The Color Page allows you to control the color options of the image. Every bitmap image has a
palette of colors that is used to display a picture. The bigger the palette, the more accurate the colors
will be, however using more colors can quadruple the amount of memory or disk space that is used
by the image.
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Color Format Information. This item displays
the color format of the original image that was
read from disk and the format of the current
image.

Color Format Options. Estierra can use
bitmap with 4, 8, 24 and 32-bits of color. Here
is a description of each color option:

4-Bit Color. This mode gives a total
of 16 colors.  Since there are two
pixels per byte, images are much
smaller, however because of the
limited number of colors, the 4-bit
color is only suitable for very simple
images such as elementary drawings
and maps.

8-Bit Color. This mode gives a total of 256 colors. Since there is one byte per pixel, images
will be of medium size. With 256 colors, the image can display more complex maps and
even photographs if as long as they don’t have a broad range of colors.

24 and 32-bit Color. This mode provides 16-million colors, which is sufficient for even the
most subtle color photographs. However, the images will be three or four times larger than an
8-bit image.

Apply New Color Format Button. Pressing this button applies any color changes that you may have
made

.

1.2.6.5.3  Overlay Options - Contours Page

The Contours Page controls the way the contour lines are drawn on the Overlay Image. Here is a
detailed description of the options:

Line Width. This option controls the width of
contour lines in pixels. The larger the number,
the wider the lines. Wider lines may be easier to
see when drawn on top of the overlay image.

Line Color. This option controls the color of the
contour lines. Changing the color may make it
easier to see the lines. For example, light
colored lines will be easier to see when drawn
on a dark image and vice versa.

Mark Points. Enabling this option causes the
program to draw marks on the map that
corresponds to the elevation points in the DEM
file. Note: if the terrain is rotated, the Mark
Points option will be disabled
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1.2.6.6 Alignment Techniques

Pick A Feature. The best technique for aligning the contour lines with the terrain is to pick a terrain
feature that you can find in both the image and the contour lines. It is best to choose features that are
distinct and sharply defined. Lakes, cliff-edges and valleys are good choices.

Contour Visibility. If you are having trouble seeing the contour lines because of the color of the
image, try changing the color or width of the contour lines. 

Decrease Contour Interval. Once you have located a terrain feature that is visible in both the
contour lines and the image, decrease the Contour Interval less than 100-feet. If your image is
topographic map, set the Contour Interval to the same value that is used by the map. 

Move and Scale. Now use the Move Buttons to position the corresponding contour lines over the
feature in the image. Now move to another part of the image and see if other features align with each
other. This time, if they out of align, adjust the scale of the contours using the Expand Contours and
Shrink Contours buttons. You continue this process, moving from feature to feature, adjusting both
the contour position and size, until all areas are correctly aligned. 

Increments. As you make your adjustments, gradually reduce the Increment value so that each
change is smaller and smaller. This will cause your adjustments to gradually converge on a perfect
alignment.

Rotations. Some images will be slightly rotated relative to the terrain. For this reason, you may need
to rotate the contour lines. Note: Once you rotate the terrain, the time it takes to draw contour lines
will increase a great deal. For this reason, you probably want to do your rotations last. Also, it may
help to increase the Contour Interval since the decreases the number of lines the program has to
draw.

Alignment Problems. Depending on how the image was scan or generated, you may have
alignment problems. For example, photographs and scanners can distort the image in ways that
make it difficult to align. Also, you may notice that the alignment is perfect in one area, but
misaligned in others. You may also notice that the image is rotated making it difficult to align. In
these cases, the best option is get a better image. Failing that, your best option is to find a
compromise alignment that you can live with. 

1.2.6.7 Geographically Registered Maps

Some maps and aerial photograph files contain detailed information about the geographic location of
the image. For example, GeoTiff files, (which Estierra can read), contain UTM information about the
location of the map. Since DEM files also contain this information, it should be possible for Estierra to
automatically align maps images to the underlying terrain.

Poor Data Quality. Unfortunately, the quality of the data in DEM’s and GeoTiff files is so bad, that it
is seldom possible to use the information. As a result, Estierra does not currently incorporate this
feature. However, this is not much of a problem because it is so easy to align the images manually.
Besides, the manual alignment capability gives you much more flexibility. It allows you to use non-
registered images scanned from books and paper maps. It also allows you to work with small sections
of terrain that are smaller than the DEM file. This is very useful for focusing on the details of the
terrain in specific areas.

1.3 DEM Files

Digital Elevation Model files (DEM) are special files that contain a grid of elevation points for a
particular part of the earth’s surface. Estierra uses these points to construct a three-dimensional
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model of the surface. The United States Geological Survey (USGS) creates and distributes DEM files
for the United States. Here is detailed information about acquiring and using DEM files:

Getting DEMs
DEM Data Format
DEM File Errors

Decompressing DEM Files
Merging DEM Files

1.3.1 Getting DEMs

Before you can create a model of the terrain, you must acquire DEM files for the area you are
working in. This data is available from United State Geological Survey (USGS) and there are several
web sites that contain the data. Here are some links:

Government Sites

Alphabetical: http://dds.cr.usgs.gov/pub/data/DEM/250/

Commercial  Sites

Free Downloads: http://data.geocomm.com/dem/
Free Downloads: http://www.mapmart.com/
Free Downloads: http://www.atdi-us.com/

Notes: you may have to do some searching to find the free downloads on these pages. The
companies that offer them are in the business of selling other information and they sometimes hide
the data away in the back part of their web pages. Nevertheless, with some persistence, you find the
data.

Also, these file often need to be decompressed and the filename changed so Estierra will recognize
them. Refer to the section on Decompressing Files for more information.

1.3.2 DEM Data Format

I. File Formats. The USGS currently produces DEM’s in two file formats: the original DEM format
and the SDTS format. Here is a detailed description of each:

DEM Format. The original format keeps all DEM data in single file, usually with the extension
“.DEM”. This file format dates back many years and has many odd artifacts and variations
that date back to the earliest days of computers. Estierra has special routines that can read
this data and deal with problems that other programs cannot handle.

SDTS. The "Spatial Data Transfer System" (SDTS) is a new standard that has been adopted
by the USGS. In the SDTS format, the data is split between half a dozen files. All the files
have the extension "DDF" and the key file has this format "????CEL0.DDF," where the
question marks can be any characters. Here are two real examples:
 
6221CEL0.DDF
7103CEL0.DDF

II. File Sizes. DEM files come in several sizes and resolutions. The most common are one degree
and 7.5 minutes files. 

One Degree Files. The one-degree files cover one square degree of the earth's surface. This covers
a rectangle about 50 miles wide and 60 miles high at middle latitudes. At the standard resolution the
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data points are spaced about 300 feet apart. This means that hills, valleys, sinkholes and other
features smaller than 300 feet, may not be visible on these maps. One-degree files are readily
available over the Internet free of charge. Click here for links to DEM download sites. 

7.5 Minute Files. A 7.5-minute file covers a smaller portion of the land surface and their data points
are much closer together, typically 90 feet, although some versions are as close as 30 feet. This
gives much finer detail than one-degree maps. The files are also smaller, about one megabyte apiece
uncompressed.

The quality of some of the 7.5-minute data is poorer than the one-degree maps. Some of the files
seem to have artifacts in them, like horizontal lines through the data or rectangular blocks equal
elevation. Click here for links to DEM download sites. 

1.3.3 DEM Errors

Many DEM files have errors in them. These errors come from a variety of sources. Some errors are
introduced when the original data was created. Other errors are introduced when the data is
translated between different formats.

Estierra can compensate for many DEM errors so that a defective file can still be used. However, the
errors can distort the surface terrain or produce inaccurate geographic coordinates. To find detailed
information about the DEM file errors, select the “View|DEM Error Info” option from the menu bar.
The window will display a list of DEM errors. Here is a detailed description of each error type: 

Carriage/Line Feed Return Embedded. The DEM file format specifies that there should be no
Carriage Return or Line Feed (CR/LF) characters embedded in the DEM data. In some cases, DEM
files will have CR/LF embedded in them, presumably to make them more easily edited with a text
editor. (DEM files are divided into 1024 byte blocks, which is a throwback to when the data was
stored on magnetic tapes with 1024-byte record size. For some reason, some programs insert CR or
LF characters at the end each block, however, this is not a part of the USGS standard.)

These CR/LF characters will shift the position of certain fields in the file, making them difficult for
most programs to read and display the data.  Estierra removes these characters so that file can be
read, displayed and manipulated. This process generally leaves no residual problems, but it does
indicate that the file is non-standard and other inconsistencies may exist, making the data unreliable.

Invalid Corner Values (0). Each DEM files specifies the geographic location of the quadrangles
boundaries. If this information is missing, the Estierra cannot accurately locate the DEM’s position on
the earth. It also cannot display or manipulate the DEM. For this reason, the program will substitute
dummy corner coordinates. This at least allows the DEM to be displayed and manipulated. However,
all location information will be inaccurate. 

Profile outside boundaries. The elevation points in a DEM file are organized into north-south
columns called “profiles.” Every point in a profile should fall inside of the boundaries specified by the
file. This error occurs when the location of an individual profile or data point falls outside the
boundaries specified in the file. This can cause part of the data hidden off the edge of the screen.

To solve the problem, Estierra will adjust the data so that all points will fall within the boundaries and
will be displayed, however this may cause certain columns to be shifted northward, distorting the
image. The error also indicates an internal consistency problem and it may indicate other aspect of
the data is inaccurate.
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1.3.4 Decompressing DEM Files

Decompressing Files. If you download a file in the compressed form, you must decompress it
before it will be usable by Estierra. The files are generally compressed in one of two formats. You
can usually tell which format by the extension. Here is a complete description of each type:

ZIP Files. ZIP files have the extension “ZIP”. If you are using Windows XP, the operating systems
treats ZIP files as though they were ordinary folders. This means that to extract data from a ZIP file,
all you have to do is remove it from the folder. If you are using a different operating system, you will
need to use WinZip or IZArc to decompress the file. Once one these programs is installed on your
computer, you can just double click on a ZIP file and the program will automatically decompress it.
(See below for more information on WinZip and IZArc.)

WinZip/IZArc. There are several programs that will decompress these two files. I have used two
programs to decompress files. WinZip is a shareware program and IZArc is free. I current I prefer to
IZArc. Here are links for download the programs:

WinZip: http://www.winzip.com/
IZArc: http://www.izsoft.dir.bg 

GZ Files. Many DEM files, particularly the SDTS files are compressed using GZip format. GZip files
have the extension “GZ”. To decompress these files you will need to use Winzip or IZArc, installed on
your computer. Here are the steps for extracting DEM files.

1. Correct Extension. Sometimes these files will be described as being GZip files but won’t have the
proper extension. Programs like WinZip and IZArc need to be able to find an extension in order to
process the file. For this reason, you may need to change the extension to “GZ” for the file. 

2. Open GZ File. You should now double click on the GZ file. If WinZip or IZArc is installed on your
computer, one of them will open the GZ file and display the contents.
 
3. TAR Files. Some of these compressed files will contain a “TAR” file. If so, you should double click
on the file so the decompression program can open it too. At this point, WinZip may ask you for an
extension for this file. Just give it an extension of TAR. This will enable WinZip to understand that it is
a TAR format archive file and it will automatically extract all the files inside. IZArc seems to be able
to open the file without changing the extension.

4. Copy Files. Once WinZip or IZArc has opened the TAR file, copy the contents to your hard drive.

5. Correct Extension. DEM files normally have the extension DEM or DDF. Esterria relies on these
extension to display available files when you open and load a DEM file. Some DEM files will be
missing the extension or will have an extension such as "txt." These are usually ordinary DEM file
and not the SDTS files. If you have one of these files, you need rename it so it has the DEM
extension. For example if you have a file named: "PikesPeak" you should rename it "PikesPeak.
dem." Likewise if the file is name "PikesPeak.txt" you would rename it "PikesPeak.dem."

 

1.3.5 Merging DEM Files

Sometimes the area of interest on a DEM falls on the border between to files. For this reason, 
Estierra can merge any two DEM files. It does this by creating a new DEM file that combines parts of
the two original files. After the two files have been merged, the edges of the original files will be
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moved to the center of the combined file. To combine files, select the “Tools|Merge DEM Files”
option from the menu bar.

Caveats. The merge capability has been tested with one-degree and 7.5-minute DEM files. It may be
able to process other scales, but these have not been tested. The program is designed to process the
original DEM format and but not the new SDTS format files. If you are using SDTS format data, you
must convert them to the old format.

Merge Direction. The program
can combine two files that are
adjacent in the east-west
direction or in the north-south
direction. The file merging utility
window has two pages, one for
merging west-east files and one
for merging south-north files. The
first step in merging files is to
select the proper page.

Choosing Files. Each page has
two edit boxes for the west and
east files or the south and north
files. You can type the filename
into each box, or you can use the
browse button to search for and
select the proper files. 

Pan Factor. Once you have selected the files to merge, you can set a Pan Factor. The Pan Factor
controls what proportion of the two source files will appear in the output file. For example, if you
select a Pan Factor of 50%, half of each file will appear in the new combined file.
Smaller Pan Factors mean more of the west or south files will appear in the new file. Large Pan
Factors mean more of the east or north files will appear in the new file. 

Merging Files. After you have selected files and a Pan Factor, press the "Merge" button. The
program will prompt you for an output file and then combine the two files.

Merging Corners. For locations that fall at the corners of four DEMs, you can merge all four files.
First, you combine the two pairs of adjacent files in the east-west direction. This will created two new
combined files. Finally, you combine these two files in the north-south direction. Be sure to use the
same pan factor for each of the pairs of files.

Errors And Problems. You may encounter errors or problems when you attempt to merge DEM
files. Here are detailed descriptions of some the problems you may see:

1. Non-Adjacent Files. The two source files must represent land areas that are immediately adjacent
to each other. They also must be specified in the correct order. Otherwise, the program will not be
able to join the edges of the data. If the files are not adjacent, the program will tell you how far apart
the edges are and ask if you really want to merge the files. 

2. Anomalies. Anomalies may exist at the border between two files. There are two types of
anomalies. The first kind is missing data points and gaps at the border of the files. These due to
inconsistencies in the way the DEM are created by the USGS. The second type of anomaly is the
result of an elevation offset between the two files. For example, the elevations of one file could be
consistently 30 feet high than the other file. This would result in a hump at the boundary of the file. 
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1.3.6 Convert SDTS Files

Estierra can read both the old-style DEM files and the new SDTS files. However, the new files are
awkward to use because they need 18 files just to old one DEM map. For that reason, it is sometimes
useful to convert the newer files to the old format. Also, Esterria requires the old style files if you want
to merge adjacent DEM files.

To Convert an SDTS file to the old format you need to get a the Compass files converter. You can
find a copy here.

http://www.fountainware.com/compass/download.htm

The "SDTS Converter" can be found half-way down the page. Follow the instructions in the help file.

1.4 Terrain Special Effects

Estierra has a number of special effects that can be applied to terrain models such as coloring by
depth and slope. Here is detailed information on special effects:

Special Effects Adjusting Color Bars

1.4.1 Special Effects

The Terrain Special Effects options allow you to color and enhance the terrain in a variety of ways.
To access these special effects, select the “Terrain|Special Effects” option from the menu bar.

The Special Effects are divide into two pages. Each Page is select by clicking on the tabs at the top
of the windows

I. Depth Effects. The Depth Effects are available on the first page of the Special Effects dialog. The
Depth Effects allow you to color the terrain by depth. You have complete control over the hue, range
and distribution of colors. Here are descriptions of the color by depth features:

A. Depth Color Bar. The
Depth page has a "Color Bar"
on the left side of the page that
graphically illustrates the
distribution of colors. Each
color band represents a
particular depth in the terrain.
You can set the color, position
and width of each band
individually, there by creating a
broad range of color effects.

B. Color Mode. This option
allows  you to select different
color schemes with different
numbers of colors.
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C. Color Depth Button. Pressing
this button causes the program to
color the terrain according to the
colors in the Depth Bar. In this
mode, the program uses a bitmap
image to color the terrain, which
produces a more precise color
pattern, with very sharp contour
lines.

D. Color Faces Button. Pressing
this button causes the program to
color each face in the terrain
according to the Color Bar. In this
mode, the colors are more diffuse
and less precise, but more natural
and smooth.

II. Color-By-Slope. The Color-By-Slope
option appears on the second page and it
allows you to color the terrain according to
the steepness of each face of the terrain.
This will give color-coded information
about the steepness of the terrain. It can
also give a realistic appearance to a
terrain for which you do not have an 
Overlay image. Here are detailed
instructions for using the Color-By-Slope
option:

A. Slope Color Bar. The Slope
page presents a "Color Bar" on
the left side of the page, which
graphically illustrates the
distribution of colors. Each color
band represents a particular range
of slopes in the terrain. For
example, bands at the top of the
color bar will represent faces
whose slope is near to 90
degrees. Likewise, the bands at
the bottom of the color bar
represent slopes near zero
degrees. By manipulating the
color bands, you can map any
color to any slope.

Default Colors. The default color set for the Slope Color Bar uses greens for flat terran. This
logical because flat terrain is more likely to have plant growth than steep cliff. Likewise,
steeper terrain is colored with grays and pinks simulating the rocks that you would expect to
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see exposed on very steep terrains. This color pattern gives a realistic appearance to terrain
as long as you don’t zoom in too close.

B. Color By Slope Button. Pressing this button causes the program to color the color the
terrain according the slope and the color bar.

1.4.2 Adjusting Color Bars

Overview Of Color Bars. Color Bars are columns of color bands that are used to set the colors for
3D objects. Generally speaking, the position each of the color in a Color Bar corresponds to a
physical property of the object such as depth. Several features of Estierra use Color Bars to set the
colors of terrains.

Adjusting Color Bars. Color Bars are
adjustable in a variety of ways. Here is a
description of how to manipulate Color Bars: 

Selecting Colors. You can select any color
band by clicking-on it. When a color is selected,
a dotted line appears around the border of the
color band. Once a color is selected, you can
change the color by clicking on the "Set Color
"Button.

Dragging Colors. You can also copy colors
from one band to another by clicking on a color
band and then dragging the color to a new band.
This will copy the color to the new band.

Dragging The Tops and Bottoms. You can
also manipulate the Top and Bottom values of a
color band by moving the mouse cursor to the
line separating the bands and then dragging the
line to a new position. This will resize and
reposition the adjacent bands.

Reset Spacing. The "Reset Spacing" button restores the original even spacing of the bands. 

Reset Colors. The "Reset Color" button restores the default colors of the bands. 

Color Gradient. The "Color Gradient" button takes the top and bottom color bands and creates a
smoothly changing series of intermediate colors. This is useful for creating special color effects.

Space Evenly. The "Space Evenly" button takes the top and bottom of the color bar and spaces all
the bands evenly. This allows you to set a narrow range of evenly spaced color bands. The "Space
Evenly" button is different from the "Reset Spacing" button. The "Reset Spacing" button resets the
color bar to the original spacing; whereas, the "Space Evenly" button maintains the position of the top
and bottom bands and then evenly spaces all the intermediate bands.
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1.5 Device Drivers

OpenGL uses special software called "Device Drivers" to take advantage of the capabilities of today's
graphics cards. When Estierra first starts running, it tries to select the best or most powerful device
driver. You have the option of choosing a different device driver that may work better on your
computer.

Reference Drivers. OpenGL usually installs a set of “Reference Drivers” on your computer. These
are drivers that will work on any system and they are meant to be the standard from which all other
drivers are written. They do not take advantage of hardware acceleration so they are slow, but they
always work. Reference Drivers can be useful for diagnosing problems with Estierra. If you switch to
a Reference Driver and the problem goes away, it is probably caused by your device driver and you
should contact the card manufacturer for a driver-upgrade. Finding and selecting Reference Drivers
are discussed below.

Changing Drivers. To change device drivers, select "Render|Devices" from the menu bar. This will
display a list of device drivers available on your computer. The current device driver will be
highlighted. To select a different device driver, simply highlight the driver and click on the Okay
Button. 

The Device Driver display has four different sections. Here is detailed explanation of each section: 

1. Device Driver. This item shows the name of the device driver. Usually there will be at least three
drivers: "Default", "Ramp Emulation" and "RGB Emulation". The Default driver is a driver that is
guaranteed to work on any machine. Estierra will choose this driver if it cannot make any other driver
work properly. The other two drivers are standard software drivers that are included with every
installation of OpenGL. If you have an accelerated graphics card that has been properly installed, you
will have other drivers that support the advanced features of your card. 

2. Hardware. This item specifies whether the driver supports the accelerated hardware on your
graphics card. Hardware drivers can be as much as 50 times faster displaying and animating the
images than software-based drivers. All non-hardware-based drivers are Reference Drivers.

3. Color Mode. This item specifies how the driver will deal with colors. In Mono mode, the number of
colors is limited and all lights are white. In RGB mode, there are more colors in the display and all
lights can have colors. RGB mode works better with the Fog and Texture Filtering options. However,
if Windows is set 8-bit graphics mode (256 colors), you may get banding effects in your colors. 

4. Device ID. This item display the Identification Number (GUID) of the device driver. This is useful
for debugging  OpenGLproblems. 

Choosing Device Drivers. When Estierra starts, it will try to pick the best device driver. Normally, it
will try to choose a hardware driver that supports RGB coloring. This is because a hardware driver will
be faster and RGB will produce better colors. However, there are many situations where Estierra
may not choose the best driver. 

Hardware drivers are usually written by the manufacturer of the video card and sometimes they have
bugs that prevent them from working correctly. For example, I have seen hardware drivers that don't
render textures correctly or produce jerky motions. When this happens, it may be useful to choose
one of the other drivers. All the Microsoft software drivers have been extensively tested and will
always work correctly, even though they can be slower. 

Which drivers are available to you depends on what color mode you are using. Estierra can run using
8, 16, 24, and 32 bit color, however some of the faster device drivers will only run in high resolutions.
As a result, Estierra will only display the drivers that will work with the current display mode. You may
find faster drivers if you switch a different color mode. Generally, you can switch color by going to
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"My Computer" and then "Control Panel." Go to the "Settings" tab and try testing different "Colors"
options. Also, if you are running in 8-bit graphics mode, colors may be improved by choosing one of
the Mono Color drivers.

1.6 Saving/Loading Terrains

Once you have gone to all the trouble of creating a 3D terran-model, it very useful to be able to save
and reload it without going through all the steps of recreating the image. For this reason, Estierra
allows you to save complete terrain models including overlays and coloring. There are two file format
that terrains can be saved to:

1. Terrain Files. These files are the standard format for Estierra Terrains. They can save all the
details of terrains. They are the best method for saving files, although can be a bit large. To save files
in this format, select the "File -> Save Terrain File" option from the menu bar. To load a Terrain file,
select the "File -> Load Terrain File" option from the menu bar. Terrain files have the extension
"txml."

2. X Files. You can also save any terrain as  X-Files. The X-File format was developed by Microsoft,
so these files can be loaded, viewed and manipulated by other 3D imaging and editing programs. The
X-files don't always save all the details of the terrains, particularly the overlays. To save files in this
format, select the "File -> Save X File" option from the menu bar. To load an X-file, select the "File ->
Load X File" option from the menu bar. 

1.7 Printing, Copying and Saving Images

You can print, copy to the clipboard or save as a bitmap any of the images displayed in Estierra.
There are four Estierra Pages that show images: the DEM Reader Page, the Topo EditorPage, the
3D Editor Page and the Overlay Page. The images on any of these pages can be printed, copied to
the clipboard or saved to a file:

Printing. To Print an image, select the “File|Print Image” option from the menu bar. The
program will prompt you to choose one of the four Estierra Pages. Next, it will display the
standard print setup window. You have the option of fitting the image to page or printing at
the actual size. Fitting to the page is usually the best option because the images will be very
small other wise.

Warning!  Printing images with a black background can cause problems with inkjet printers
to. Printing a picture will a black background will usually soak the paper. With the 3D Editor
page, you can set the background color to white another light color to circumvent the
problem.

Saving As Bitmap. Any Estierra Image can be saved as a bitmap file (.bmp). This allows
you to import the images into a word processors or drawing programs. To save an image,
select the “File|Save Image As Bitmap” option from the menu bar. The program will prompt
you to choose one of the four Estierra Pages. Finally, you will be prompted to select a
filename for your bitmap file.

Copying To The Clipboard. To copy an image to the clipboard, select the “Edit|Copy
Image” option from the menu bar. The program will prompt you to choose one of the four 
Estierra Pages. After you choose a page, the image will be copied to the clipboard.
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1.8 Environmental Options

The program allows you to display parameter in either meters or feet. You can set the proper units by
selecting "Options|Environmental Options" from the menu bar.

1.9 Geographic Coordinate Systesm

There are several systems that are used by cartographers to locate landmarks and terrain on the
surface of the earth. Here is a description the systems that are used by Estierra:

Longitude And Latitude. One of the standard systems for locating a point on the face of the earth is
called longitude and latitude. The system measures the location of a point on the surface of the earth
in degrees. Longitude measures the number of degrees east or west of a north/south line (meridian)
that runs through Greenwich, England. Latitude measures the number of degrees north or south of
the equator. 

Longitude and Latitude are usually displayed in Degrees, Minutes and Seconds. It is often displayed
on maps with single and double quotes used to specify the minutes and seconds part: 

106º 37' 30" 

Longitude and Latitude can also be displayed as decimal degrees. For example: 

106º 37' 30"      =   106.625 

Locations west of the England have negative longitudes and locations east of England have positive
longitudes. Locations north of the equator have positive latitudes and locations south of the equator
have negative latitudes. 

Geodetic Datum. One of the problems with any measurement on the surface of the earth is the fact
that the earth is not a perfect sphere. In fact, it has a lumpy pear shape to it. To deal with this
problem surveyors have developed complicated equations that compensate for the shape of the
earth and calculate locations. The numeric constants used to calculate locations are called Geodetic
Datum. Over the years, surveyors have gradually refined the constants to make them more and more
accurate. The result is that there are dozens of different constants that have been used to make
maps and surveys. Some of them are specially refined for particular countries or regions. For this
reason, different maps done at different times or in different parts of the world use different
constants. 

Each datum is given a special name and most maps specify which datum was used to create the
map. For example, in the United States, most maps have been created using either "North American
1927 (NAD27)" or "North American 1983 (NAD83)".

Universal Transverse Mercator (UTM). While Longitude and Latitude is universally used for
navigation, it is awkward for tasks like survey land. For example, there are several problems with
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Longitude/Latitude in this situation. First, while the earth is a sphere, most maps are printed on flat
pieces of paper. When you project longitude and latitude lines on a flat piece of paper, it inevitably
results in distortion. For example, in some projection systems, the lines will be curved. Trying to
adjust a land survey map to curved lines would be very awkward and confusing. Second, since the
longitude/latitude system uses degrees as the unit of measure, it is hard to calculate the distance
between two points.

UTM is a more useful system in many instances because it uses a square grid of Cartesian
coordinates. In order to maintain the square grid on a curved earth, UTM divides the earth into 60
narrow zones, each one six degrees wide, running north and south at right angles to the equator.
Each zone is about 415 miles (668 kilometers) wide at the equator. The zones are narrow to minimize
the effect of the curvature of the earth. This means that a square grid can be used inside the zone. It
also means you don’t have to worry about mapping against curved lines.

Each zone is numbered. Zones in the Northern Hemisphere are positive and zones in the Southern
Hemisphere are negative. Because, of the curvature of the earth, the zones narrow toward the north
and south poles.

UTM coordinates are the measured distance north from the equator and east from the left edge of the
zone. Thus with these two numbers and a zone number, you can specify the location of any point on
earth. UTM coordinates are usually specified in meters, but occasionally they may be converted to
feet.
 
Convergence. Because UTM places a square grid on top of a curved earth, the longitude lines will
appear to curve underneath the grid. For this reason, the UTM grid lines do not always point directly
at the North Pole. "Convergence" is the amount the UTM grid is misaligned with the earth's North
Pole. 
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2 Terminology and Conventions

If you are new to the computer or Windows, some of the nomenclature can be confusing. Here is a
description of some of the terminology that is used throughout this documentation:

1. Selecting Items And Executing Actions. In many situations, you will be expected to select an
object on the program window. For example, you might be expected to select a button, an edit box or
notebook tab. The easiest way to do this is to click-on it with the mouse (as described below.) With
some items, clicking-on the item also causes an action to occur. For example, clicking on a button
causes the button to be both selected and pressed.

You can also use the keyboard to select items and execute actions. This technique uses a highlight
that can be moved from section-to-section and item-to-item. For example, the “Tab” key causes the
highlight to move between sections or pages of the window. Also, the “Arrow” keys move the highlight
between individual items. Once you have moved the highlight to a particular object, you may need it
to carry out some action. You do this by pressing the “Enter” key. For example, if you move the
highlight to a button, hitting “Enter” will press the button. 

2. Clicking-On.  In many situations, you will be expected to move the mouse cursor to a specific
location on the screen and then press the left or right mouse button. This is often referred to as
“clicking-on.” So if you read that you should “click the left mouse button on” something, it means that
you should move the mouse to that location and press the mouse button.

3. Double-Clicking vs. Single-Clicking. Double-clicking means clicking twice, in rapid succession,
on the same point. In Windows, single clicking is usually used to select some item on the screen and
double clicking is used to carry out some action. However, Windows can now be configured so it
works like a web page, where actions are carried out with a single click. For this reason, when you
see the phrase “double-click” in this document, it may actually mean single-click, depending on how
you have set Windows to work. To control this option, select the  “View|Folder Options” from
Windows Explorer or My Computer.

4. Left- and Right-Mouse Clicks. There are always at least two buttons on a PC mouse. “Left-
mouse-clicking” means pressing the left button. Likewise, “right-mouse-clicking” means pressing the
right button. The left button usually carries out actions; the right button usually displays menu relevant
to the portion of the screen you are clicking on. (If you are left handed, Windows can be configured to
reverse the meaning of the buttons.)

5. Dragging. Dragging is usually accomplished by moving the mouse cursor to a specific location on
the screen, pressing the left mouse button down, and while the button remains pressed, moving the
mouse cursor to a new location. This process is usually used to highlight a large area or select more
than one object.

6. Dragging and Dropping. Dragging and dropping is usually used to move things from one location
to another. It begins the same way as dragging. That is, you begin by moving the mouse cursor to a
specific location on the screen, usually to an object on the screen. Next, you press the left mouse
button, and while the button remains pressed, you move the mouse cursor to a new location. Usually,
the object will move with the mouse cursor. This gives you the sensation of actually “dragging” the
object around. Once the object reaches its destination, you “drop” the object by releasing the mouse
button.

7. Menu Terminology. Most Windows programs have something called a “Menu Bar” at the top of
the screen. The Menu Bar has a series of words like “File, Edit, View, etc.,” along its length. If you
click-on a menu item, a menu box will drop down. Each menu box can contain additional menus so
that you may have a series of menus, one inside the other. In this documentation, a series of menu
items like this are specified by the words separated by a vertical bar. For example, “View|Toolbars|
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Forms” tells you to select “View” from the main menu bar and then “Toolbars” and then “Forms” from
its submenus.
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3 DirectoryFolder

 Folders and Directories. Folders are a way in which Windows subdivides disk space into separate
spaces. They are used to keep files separate from one and other and they are also used to help
organize information and programs. Folders can be nested inside each other and this allows you to
create hierarchical organizations. The term Folder and Directory are interchangeable. The word
Directory originated in the DOS environment and the word Folder originates in Windows. 
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